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The goal of digitization is to create Preservation Digital Objects (a TIFF or JPG2000) to serve as a surrogate 
to the original object, replacing physical access to that original object, aiding its preservation and 
broadening access to its content. The FADGI, Metamorfoze and ISO imaging guidelines outline those 
elements of image quality that are required to achieve such surrogacy. 

Many institutions focus on the resolution (PPI) and sharpness (sampling efficiency) requirements of the 
FADGI, Metamorfoze, and ISO guidelines. But the color accuracy and tonal accuracy requirements are just 
as important. 

There are three requirements for achieving preservation-grade color and tone:

- Preservation-grade Hardware
- Preservation-grade Color Profile
- Preservation Workflow

This guide addresses these three requirements in the context of solutions provided by the Digital 
Transitions Division of Cultural Heritage. Please do not hesitate to contact us with questions, feedback, or to 
arrange an in person or remote training on the topics covered in this document. 

Digital Transitions Division of Cultural Heritage
212.529.6825
info@dtdch.com

1.1 The Importance of Color/Tone Accuracy

1.2 Tools Used in this Document
Software:   Phase One Capture One CH 
   basICColor Input (for optional creation of custom in-situ profiles)

Color Targets:   ISA Golden Thread Device Level Target (for FADGI validation)
   X-Rite ColorChecker SG (for creating custom profiles)

Validation:  ISA Golden Thread (preferred for FADGI validation)
   Delt.ae (not as complete as Golden Thread, but free)

Even Fielding:  Plain gray paper cardboard. White can also work if care is taken to expose it  
   correctly (see 3.4.1).

For detailed information about the FADGI and Metamorfoze and ISO guidelines, please refer to:

Federal Agencies Digitization Guidelines Initiative (FADGI), Technical Guidelines for the Still Image 
Digitization of Cultural Heritage Materials 
www.digitizationguidelines.gov

Metamorfoze Preservation Imaging Guidelines
www.metamorfoze.nl

Photography -- Archiving systems -- Image quality analysis
ISO 19262, ISO 19263, ISO 19264

Digitization Program Planning by Digital Transitions, a Comprehensive and Practical Overview of Cultural 
Heritage Digitization
www.dtdch.com/digitization-program-planning/

1.3 Guideline References
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1.4 Types of Color Profiles
An essential requirement for accurate color and tone is the use of a preservation-grade color profile. There are 
a variety of types of color profiles that can be used with capture devices.

Standard Commercial Profiles:
General purpose cameras and photography software are designed to provide “pleasing” color in contexts 
such as casual snapshots or wedding photography. Such profiles are sometimes known as “abstract profiles” 
as they are not intended to produce accurate color. For example, commercial cameras and software will 
often attempt to render skintone with less variation than is actually present in order to even out blotches 
in the face. This can have adverse effects on paper tones; because they are similar to skintones profiles that 
attempt to render skintone with less variation will also remove subtle variations of paper tone that may reveal 
something of the condition, provenance, or meaning of paper-based cultural heritage items. 

This is just one example of the consequence of using a camera and software designed to provide “pleasing” 
rather than “accurate” color. Such cameras and software will not pass FADGI or Metamorfoze standards and 
should not be used for Cultural Heritage digitization.

In-Situ Profiles:
Because most camera/software combinations come with profiles that are designed for “pleasing” color, there 
are a variety of software packages available that allow the user to create more accurate color profiles. These 
work by having the user capture a single image of a single color chart in whatever situation the camera is set 
up and extrapolating from this single image a more general color response; this is called “in-situ profiling”. If 
executed with expertise and care this process can result in preservation-grade color profiles. 

However it is a time consuming, tedious, and error-prone process. For best results the user must also 
measure their specific target with at least one colorimeter (preferably more) since every copy manufactured 
target varies slightly from the “average” of that target type. It also requires an impractical adherence to 
the 45° lighting angle and creates profiles that are fragile to slight changes in setup. Moreover, most 
users validate the quality of an in-situ profile by another capture of the target used to create the profile 
in the first place, unaware of the circularity of this logic. Still, in-situ profiling is the only viable option for 
cultural heritage imaging when bespoke profiles cultural heritage profiles are not available for a specific 
[camera+light+software] setup. 

Bespoke Cultural Heritage Profiles:
The color science team at Phase One creates and validates bespoke cultural heritage color profiles through 
a lengthy process. They capture many color targets, each measured carefully by a spectrophotometer, in a 
nearly ideal environment (e.g. dark walls, no flare, no glare). The target captures are analyzed using proprietary 
software they’ve created in-house for just this purpose. Like any profiling software this creates profiles that 
can over fit specific points of data, so the color science team adjust these profiles using a database of real-
world captures taken under slightly varying conditions. These candidate profiles are sent to several partner 
institutions for feedback and further tweaked as needed. The end result is a robust preservation-grade profile  
with color accuracy across a variety of subtle changes in setup, without the fuss of in-situ profiling. 
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2.1 Camera Setup
There are several important aspects to take into account when selecting and preparing a camera for an 
accurate reproduction workflow.

A solid and sturdy repro stand is required to support good still captures. It should hold the camera exactly 
perpendicular to the object, isolate the camera from environmental vibration, and allow fine-tuned 
movement of the camera to easily return the camera to known capture positions. All DT reprographic 
stations meet these requirements.  

If shooting objects (e.g. vases) a sturdy tripod or studio stand is useful. All DT reprographic stations can be 
removed from the reproduction stand and placed on a tripod or studio stand. This document focuses on 
flat reproduction, but many of the concepts can be applied to object photography.

The choice of a suitable camera system for reproduction workflow can be a dedicated repro camera such 
as the DT RCam or SLR-type camera such as the Phase One XF on which the creation of capture-induced 
vibration is minimized by use of leaf shutter lenses and optional sensor-based electronic shutter. A high-
quality lens hood should be used to decrease the chance of veiling glare which can negatively impact the 
contrast of the camera.

The quality of the lens and sensor also contribute to the quality of color and tonal accuracy. For example, 
even a very slight flare can alter contrast and wreak havoc with the profiling process. The Schneider LS 
lenses and Rodenstock HR lenses used in our solutions are very flare-resistant and provide excellent 
contrast. Likewise a sensor with 16-bit output, such as that from Phase One digital backs, provide more 
precise data for profiling and validation than sensors with 8-bit to 14-bit output such as those from Canon, 
Nikon, Sony, Pentax, Fuji, Microbox and scanners such as i2s or Epson.
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2.2 Lighting Set-up & Shielding
A proper lighting setup and a well controlled environment are important for accurate reproduction of tone 
and color. The room should have gray or dark walls and ceilings rather than white, which can reflect stray 
light back onto the object from unintended angles. The station should be well isolated from neighboring 
workstations (if any) using curtains, walls, or dark foamcore V-flats. The area surrounding the object which is 
outside the camera view should also be dark or black to avoid stray light and veiling glare.

The lighting itself should use hoods or grids to minimize stray light, preferably made from a hard inflexible 
material that is conclusive to lighting consistency from one day to the next (fabric grids are workable, but 
not ideal). The DT Photon LED system has optional hard metal hoods for this reason.

For the creation of in-situ profiles the lights should be positioned as close to an incident angle of 45 
degrees as possible. With this requirement in place, the captured colors of a color target can be matched 
to the spectrophotometer-measured values delivered with your color target.

If the lights are installed such that the incident angle is varying from the 45 degree, this can greatly 
influence the measured color values of the patches of the color target. In such cases, the use of the 
captured color values as basis for generating an ICC profile using 3rd party software can generate 
unreliable results. A capture of the ColorChecker SG color target using lights positioned to deliver incident 
angles between 30 and 60 degrees can deliver color differences of up to 11 deltaE.

However, in normal digitization 45-degree illumination can be highly impractical. It can create reflections 
and specular highlights, especially on glossy material or material that is not perfectly flat. Consequently, a 
lower angle such as 35-degrees is preferred for day to day digitization.

Lower lighting angles can be used to accentuate the texture and dimensionality of the object. It’s also 
possible to light only from one side to further accentuate shadows, and then use the LCC Tool in Capture 
One to even the brightness of the subject. These techniques are covered in the DTDCH Webinar Series at 
dtdch.com/videos/
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Capture One CH contains several helpful tools and features that are specially designed for a reproduction 
workflow. This chapter shows the basic setup of Capture One CH and guides through the steps necessary 
for achieving a high quality and accurate reproduction workflow complying with the most stringent 
requirements of the FADGI, Metamorfoze, and ISO Imaging Guidelines.

3.1 Set Mode

From the tool panel, select the Color tool tab

The Base Characteristics tool includes additional options not available in Capture One Pro

A Mode selection is added in the Base Characteristics tool and is unique to Capture One CH. It allows the 
user to select basic parameters for various common workflows and easily choose between the different 
options. Three modes are available:

Photography:  All reprographic and photographic tasks other than scanning film.
Film Positive:   Use this mode for reproducing positive films.
Film Negative:  Use these modes only for reproducing negative films.

These two film modes take into account the very non-linear tone/color distribution found in film originals.  
DT makes a high-performance film scanning solution, but film scanning is not covered by this document.

Tip:
The Repro Negative mode inverts the image tonal value internally. This is most often used when capturing 
negative film materials, so that the image appears on screen as a standard (positive) image. When using 
this mode with negative materials all tools in Capture One CH behave normally, like with any positive 
original.
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3.3 Set Curve

3.2 Set Color Profile

Choose the “Linear Response” curve for most flat art reproduction. The linear response curve is linear 
throughout most of the tonal range, but provides slight compression of bright highlights that preserves 
tone and color in highlights. Select [...] and Save As Defaults to skip this step in the future.

The “Linear Scientific” provides absolutely linear 
tonal values. However because it is completely linear 
it will often lead to inelegantly clipped highlights 
when used with materials that have any gloss or 
dimensionality. So we recommend this curve only if 
you are reproducing artwork with no dimensionality 
or gloss. 

Linear Scientific is also used for creating in-situ 
profiles, as in the workflow presented in Chapter 4.

1. For 2D flat art reproduction and digitization of books, choose the specialized ICC-Profile in Capture One 
CH made for your light source. Unless you plan on changing light sources frequently you should then select 
[...] and Save As Defaults to skip this step in the future. 

Profile Description 

Flash For a setup with strobes such as Profoto using heads and rectangular soft boxes

LED DT Photon For the DT Photon and DT Photon XL LEDs made by Digital Transitions

LED DTLED36 For the first generation LED light from Digital Transitions, the DT 36 INCH LED.

Tungsten For Tungsten lights (3200K)

LED Rosco For the Rosco, Model LitePad Axiom Daylight LED. Only available for some backs.

North Light HID For the legacy Northlight HID light. Only available for some backs.

For more information about Capture One CH specialized ICC-Profiles please refer to Chapter 1.4
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3.4.1 Capture LCC Raw File
The Lens Cast Calibration (LCC) Tool helps you to create luminance uniformity for your reprographic setup. 

1. Place a plain gray cardboard on the surface of your repro table. 

Make sure that you place it flat and flush against the table and that it covers the complete field of view. It is 
important that there are no objects other than the gray board visible in the image. Therefore choose a plain 
gray cardboard that is larger than the material you want to photograph.

2. Capture an image of the cardboard covered scene using the same aperture and lighting as you’ll use 
for the actual object. It’s very important that no part of the image is blown out (e.g. 255 RGB value) or 
anywhere close to it. With a gray board this is easy to achieve with a normal exposure. 

However, if needed adjust only shutter speed or the strength of the light source for balancing the exposure. 
The aperture has a significant influence on this reference and should be set to the value you want to use for 
image capture. The resulting image should look similar to the sample shown.
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Method Two
Via the Lens tool tab select the image of the 
captured gray cardboard in the Browser and choose 
Create LCC in the LCC tool. 

After pressing Create LCC (either started with the 
first or second method), a dialog box will open 
showing the following options for the LCC profile 
that will be calculated. DO NOT check any of the 
options. Press Create to start the calculating process.

After calculating you should see the selected reference 
image of the captured gray cardboard marked as a 
LCC reference file. The letters LCC will appear above 
the thumbnail image. In the LCC tool the boxes 
for Color Cast and Enable Uniform Light should be 
checked and available. You have now created a valid 
LCC Profile for this capture setup.

Note:
An LCC profile is only valid and usable for images 
taken with the same Digital Back or Camera under 
identical lighting conditions. You have to prepare a 
new LCC Profile to create luminance uniformity if 
you:
- Change the aperture
- Change the distance to the subject
- Change the angles of the light setup
- Change the lens or digital back

You can now generate an LCC profile from the 
image of the gray cardboard. There are two possible 
ways to begin:

Method One
Right-Click on the thumbnail of the gray cardboard 
and select Create LCC. 

Tip: On a Mac without a right mouse button, use 
“CTRL + mouse click” for entering the context menu.

3.4.2 Create LCC Reference

Tip:
You may wish to rename the capture of the gray board before you generate the LCC from it. For example, 
you could name it “72mm, f8, 600ppi distance”. This will be the name of the LCC that is subsequently 
applied to incoming captures and will be more intuitive. 
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3.4.2 Create LCC Reference

3.5.2 Application of LCC (Manual)

3.5.1 Application of LCC (Automatic)
In the Camera tool tab there is a tool called Next Capture Adjustments. When shooting tethered 
with the camera attached to the computer, you can choose the settings and adjustments to be 
applied to the next capture. The factory default setting is useful in this example to automatically 
apply the LCC profile.

The first option – ICC Profile is set to Default in the factory default settings so it will choose the ICC 
Profile you set in the Base Characteristics tool (See also Chapter 3.2)

The All Other option is set to Copy from Last by default. This will ensure that every setting that is 
made with one of the Tools in Capture One is automatically applied to the next captured image. 
This includes the newly created LCC profile from the last image. All subsequent images will be 
precisely corrected, using this LCC, until you make changes to the lighting.

To manually apply an LCC profile to another image, select the LCC reference image (with the letters LCC 
tagged above) together with all images that you wish to apply this LCC profile to. Then Right-click on one 
of the images with your mouse or CTRL-click to access the context menu and select Apply LCC.
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Setting the correct white balance is as important as 
setting the correct exposure. The white balance can 
be measured with the white balance picker.

The White Balance picker is located in the Cursor 
Tools.

It can also be found in the Color Tool Tab in the 
White Balance Tool or in the Capture Tool Tab in the 
Camera Tool.

The ideal patch to set White Balance is Patch 13 
on the ISA Golden Thread target or patch F5 on a 
ColorChecker SG.

Click on that patch with the White Balance 
cursor. If using RGB values should become equal 
after clicking to set the White Balance, or have a 
maximum of one or two values in difference. If using 
LAB values the A and B values should drop to a 
fraction of a point.

3.6 Set White Balance
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3.7 Set ExposureTo ensure correct exposure, you will make sure a 
specific patch in your chosen target conforms to its 
ideal value. 

How to Measure
Hover the cursor over the patch in the viewer and its 
values are shown in the middle above the image.

Capture One also provides an option to have 
multiple readouts displayed in various areas of the 
image. Click and hold on the second to last cursor 
icon and select Add Color Readout.

LAB vs RGB
RGB values vary based on which output color space 
is used while LAB values are the same in any output 
color space. 

To use LAB Readouts rather than RGB select [View > 
LAB Readout > GoldenThread (ICC)].

NOTE: LAB values are only available in Capture One 
CH. They are not available in Capture One DB / Pro.

What to Aim For 
The Golden Thread ISA Target patch 15 should have 
a Luminance value of 62.2 or an RGB value of 149.

The ColorChecker SG target patch G5 should have a 
Luminance value of 65.1 or an RGB value of 156.

NOTE: The above values are based on the “average 
target” and assume use of the Adobe 1998 output 
and a 45° angle of illumination. See Chapter 6.3 for 
additional aim point information and Chapter 6.4 
for more technical details.

What to Adjust
To achieve the correct exposure you should mainly 
rely on changing the shutter speed (for DT Photons) 
or strobe power (for strobes such as Profoto). 
However, small positive values (e.g. <0.2 stops) can 
be used on the Exposure slider in Capture One.

Why Measure Gray Rather than White or Black
Some guides would suggest using a white patch 
(e.g. patch 10 on an ISA target or Patch E5 on 
a ColorChecker SG) to set the exposure. This is 
acceptable when Linear Scientific curve is selected. 
But the Linear Response curve has a slight rolloff in 
the highlights, so setting the exposure based on a 
white patch when using Linear Response will result 
in an overexposed image. 

Using the recommended gray patches works equally 
well with Linear Response and Linear Scientific.

How Accurate Must You Be
A point or two of variation is not necessarily 
cause for alarm. This is especially true if you have 
not measured your specific physical chart; every 
manufactured chart is slightly different. 

Chapter 5 “Image Quality Analysis  & Standards 
Validation” covers methods to analyze your capture 
to determine its quality of reproduction. 17
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A preservation-grade ICC profile is essential to achieving accurate color and tone. Capture One CH already 
contains a wide list of ready-made ICC profiles for high accuracy color reproduction for digitizing projects in 
Cultural Heritage use. These profiles are created with expertise and care, specifically for the combination of 
digital back model and lighting. Combined with the individual digital back factory calibration (a multi-hour 
process!) these profiles are extremely accurate and robust. If these profiles suit your workflow (i.e. you are 
using one of the light sources and digital backs for which a profile is already included in Capture One CH) 
then using that profile is always preferable to the cumbersome, error prone, and fragile process of in-situ 
profiling.

However, sometimes these ready-made ICC profiles of Capture One CH do not fit your environment, 
equipment or lighting. Alternatively, you may be using Capture One Pro or Capture One DB, which do not 
contain our ready-made ICC profiles made for Reproduction use. The following Chapter shows a possible 
workflow for creating a custom ICC-Profile using 3rd Party Software. In this example we use basICColor 
Input.

4.1 Set Mode
From the tool panel, select the Color tool tab

The Base Characteristics tool includes additional options not available in Capture One Pro

For generating an in-situ profile select Photography.

For more information on other modes see Section 3.1.
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Because we are capturing an image that will be used to generate a profile, it is important that we show the 
native unprofiled response of the camera. Otherwise we will be “double profiling” the system.

To do so, under ICC Profile, select “Effects > No Color Correction”. It may be necessary to select Show All 
from the ICC Profile Menu in order to gain access to all the ICC-profiles; the No Color Correction Profile can 
be found in the Effects sub-folder.

Note: Later, when capturing an image using the in-situ profile (rather than capturing an image to create 
that profile), you will be changing this setting to use the profile created in this Chapter, rather than the “No 
Color Correction” profile.

4.2 Set Color Profile

4.3 Set Curve
When creating an in-situ profile it’s essential to provide the profiling software an image of the color chart 
that has an absolutely linear response. Therefore choose the “Linear Scientific” curve .

Later, when using the in-situ profile to capture material (rather than capturing an image to create that 
profile), you may want to switch to Linear Response. See Chapter 3.3 for more information on curves for 
day-to-day captures.
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4.4.1 Capture LCC Raw File
The Lens Cast Calibration (LCC) Tool helps you to create luminance uniformity for your reprographic setup. 

1. Place a plain gray cardboard on the surface of your repro table. 

Make sure that you place it flat and flush against the table and that it covers the complete field of view. It is 
important that there are no objects other than the gray board visible in the image. Therefore choose a plain 
gray cardboard that is larger than the material you want to photograph.

2. Capture an image of the cardboard covered scene using the same aperture and lighting as you’ll use 
for the actual object. It’s very important that no part of the image is blown out (e.g. 255 RGB value) or 
anywhere close to it. With a gray board this is easy to achieve with a normal exposure. 

However, if needed adjust only shutter speed or the strength of the light source for balancing the exposure. 
The aperture has a significant influence on this reference and should be set to the value you want to use for 
image capture. The resulting image should look similar to the sample shown.
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Method Two
Via the Lens tool tab select the image of the 
captured gray cardboard in the Browser and choose 
Create LCC in the LCC tool. 

After pressing Create LCC (either started with the 
first or second method), a dialog box will open 
showing the following options for the LCC profile 
that will be calculated. DO NOT check any of the 
options. Press Create to start the calculating process.

After calculating you should see the selected reference 
image of the captured gray cardboard marked as a 
LCC reference file. The letters LCC will appear above 
the thumbnail image. In the LCC tool the boxes 
for Color Cast and Enable Uniform Light should be 
checked and available. You have now created a valid 
LCC Profile for this capture setup.

Note:
An LCC profile is only valid and usable for images 
taken with the same Digital Back or Camera under 
identical lighting conditions. You have to prepare a 
new LCC Profile to create luminance uniformity if 
you:
- Change the aperture
- Change the distance to the subject
- Change the angles of the light setup
- Change the lens or digital back

Method One
Right-Click on the thumbnail of the gray cardboard 
and select Create LCC. 

Tip: On a Mac without a right mouse button, use 
“CTRL + mouse click” for entering the context menu.

4.4.2 Create LCC Reference

Tip:
You may wish to rename the capture of the gray board before you generate the LCC from it. For example, 
you could name it “72mm, f8, 600ppi distance”. This will be the name of the LCC that is subsequently 
applied to incoming captures and will be more intuitive. 
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4.5.2 Application of LCC (Manual)

4.5.1 Application of LCC (Automatic)
In the Camera tool tab there is a tool called Next Capture Adjustments. When shooting tethered 
with the camera attached to the computer, you can choose the settings and adjustments to be 
applied to the next capture. The factory default setting is useful in this example to automatically 
apply the LCC profile.

The first option, ICC Profile, is set to Default in the factory default settings so it will choose the ICC 
Profile you set in the Base Characteristics tool (See also Chapter 3.2)

The All Other option is set to Copy from Last by default. This will ensure that every setting that is 
made with one of the Tools in Capture One is automatically applied to the next captured image. 
This includes the newly created LCC profile from the last image. All subsequent images will be 
precisely corrected, using this LCC, until you make changes to the lighting.

To manually apply an LCC profile to another image, select the LCC reference image (with the letters LCC 
tagged above) together with all images that you wish to apply this LCC profile to. Then Right-click on one 
of the images with your mouse or CTRL-click to access the context menu and select Apply LCC.
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Setting the correct white balance is as important as 
setting the correct exposure. The white balance can 
be measured with the white balance picker.

The White Balance picker is located in the Cursor 
Tools.

It can also be found in the Color Tool Tab in the 
White Balance Tool or in the Capture Tool Tab in the 
Camera Tool.

The ideal patch to set White Balance is Patch 13 
on the ISA Golden Thread target or patch F5 on a 
ColorChecker SG.

Click on that patch with the White Balance cursor. 

If using RGB values, they should become equal 
after clicking to set the White Balance, or have a 
maximum of one or two values in difference. If using 
LAB values, the A and B values should drop to a 
fraction of a point of each other.

4.6 Set White Balance
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4.7 Set ExposureTo ensure correct exposure, you will make sure a 
specific patch in your chosen target conforms to its 
ideal value. 

How to Measure
Hover the cursor over the patch in the viewer and its 
values are shown in the middle above the image.

Capture One also provides an option to have 
multiple readouts displayed in various areas of the 
image. Click and hold on the second to last cursor 
icon and select Add Color Readout.

LAB vs RGB
RGB values vary based on which output color space 
is used while LAB values are the same in any output 
color space. 

To use LAB Readouts rather than RGB select [View > 
LAB Readout > GoldenThread (ICC)].

NOTE: LAB values are only available in Capture One 
CH. They are not available in Capture One DB / Pro.

What to Aim For 
The Golden Thread ISA Target patch 15 should have 
a Luminance value of 62.2 or an RGB value of 149.

The ColorChecker SG target patch G5 should have a 
Luminance value of 65.1 or an RGB value of 156.

NOTE: The above values are based on the “average 
target” and assume use of the Adobe 1998 output 
and a 45° angle of illumination. See Chapter 6.3 for 
additional aim point information and Chapter 6.4 
for more technical details.

What to Adjust
To achieve the correct exposure you should mainly 
rely on changing the shutter speed (for DT Photons) 
or strobe power (for strobes such as Profoto). 
However, small positive values (e.g. <0.2 stops) can 
be used on the Exposure slider in Capture One.

How Accurate Must You Be
For the purposes of creating an in-situ profile you 
should aim to be as accurate as possible. After 
adjusting shutter speed or strobe power, use the 
exposure slider which can be used in 0.01 stop 
increments. Only use positive values on this slider. 

For best results creating profile you should measure 
the values of your specific chart; every manufactured 
chart is slightly different. See Chapter 6.5.
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The CCSG target has to be cropped out of the 
image. The export file should only contain the 
target.

If you are using Capture One CH the easiest way is 
to use the Autocrop Tool

1. Select the image to be cropped.
2. Select Method: Loose Material
3. Select Straighten: Top Edge
4. Select Prepass: Medium Obj:BG Contrast
5. Click the Auto Crop Button

The CCSG target should be automatically 
straightened and cropped.

As an alternative to AutoCrop (e.g. when using 
Capture One Pro rather than Capture One CH)

From the Tool panel, select the Crop Tool Tab

Select the crop tool and create a crop that only 
includes the ColorChecker SG.

From the Tool panel, select the Rotation & Flip Tool. 
Select the Straighten Tool and draw a line along the 
edge of the ColorChecker SG target or between the 
crosses if your CCSG has them.

4.8.1 Crop Target

Tip: 
You can also find the Crop and the Straighten tools 
in the Cursor Tools.
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1. From the tools panel, select the Output tool tab.

4.8.2 Export Target

2. Add a new recipe by clicking on the + button and 
type in a name for the new recipe.

3. Choose the TIFF File Format in 16bit, 
uncompressed. 

5. Select and Check Process Recipe 

Ensure that the box to the left of your new defined 
Recipe is checked, and no other Recipes are 
checked.

4. Choose the Embed camera profile ICC Profile

Note: These settings along with the No Color 
Correction and Linear Scientific that you chose in 
the Base Characteristic tool ensure that you export 
a completely linear file.
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Tip: 
To easily identify the exported reference image you 
can use the Output Naming Tool located in the 
Output Tool Tab and add a Job name. For example, 
add “_CCSG” to the reference image.

6. To export the TIFF file select the image in the  
browser.

7a. Click Process in the Process Summary Tool  
that is located in the Output Tool Tab.

7b. Or click the Process Symbol in the upper 
Toolbar.

28



basICColor Input 5 can be used to analyze the capture of the ColorChecker SG and create an in-situ profile. 
It is available for both MacOS and Windows. Digital Transitions is a dealer for basICColor.

The steps below assume basICColor Input 5 is already installed and activated per the Installation Guide.

1. Select the CCSG Repro preset.

4.9. Create Profile in basICColor Input

When to use another preset
The CCSG Repro preset is appropriate for calibrating using an X-Rite ColorChecker SG target and strobe or 
DT Photon. If you are using another target or another illuminant select the appropriate preset or create a 
new preset by selecting Preset Editor. 

About the Reference
Targets such as the ColorChecker SG vary in slight ways from year to year. Moreover every copy 
manufactured varies slightly from the “average” of that target type. For best results check the “Reference” 
listed in the CCSG Repro preset against the age of your target. Advanced users can also improve the accuracy 
and consistency of the calibration process by measuring the patches of their target using SpectraShop (see 
Chapter 6.5) and loading those values into basICColor.

Here are the settings the CCSG Repro preset uses:
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2. Drag and drop the TIFF from Chapter 4.8.2 onto 
the “Drag and Drop” icon.

Place the grid over the image of your X-Rite
ColorChecker SG using the four corners of the
Grid to move and fit. Ensure that all measuring 
fields cover only a single patch.

After placing the grid correctly you will have a first 
view of the quality of your reference image. The sun 
symbols are placed over the white patches around 
the chart’s edges. If they show green borders this 
means the illumination is acceptably even.

3. Name your profile

Tip: If the profile follows the naming convention 
used for Phase One ICC Profiles, Capture One CH 
will automatically place it together with the Original 
ICC-Profiles that came by default with Capture One.

The naming convention is the Product Name (no 
spaces) followed by a dash. For example: 
 PhaseOneIQ180-CustomICCprofile.icc or
 PhaseOneIQ3100-Nameitasyoulike.icc

4. Click “Start Profiling” 

Once complete you will be able to compare your 
ICC profile to other ICC profiles on your system. 
You can also drag the slider on the top right to 
determine which percentage of patches are less 
than or equal to the ΔE listed.

The new ICC-profile will be automatically saved in 
the ColorSync Folder of your Operating System.
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1. Restart Capture One if you added a custom 
ICC Profile from another application. This allows 
Capture One to recognize the new profile and to 
add it to the list in the Base Characteristics tool in 
the Color tool tab.

2. In the Base Characteristics tool, change the 
ICC-Profile from Phase One Effects > No Color 
Correction to your own custom made profile.

Note: As noted in Chapter 4.9 item 3, if you follow 
the naming convention used for Phase One ICC 
Profiles, Capture One will automatically list the 
profile alongside other profiles for your camera 
model. If not, the new ICC-Profile will appear in the 
Other Chapter in the ICC Profile dropdown menu.

4.10. Set Capture One to Use Profile
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3. To ensure that this new custom ICC profile is 
the new default ICC profile for your reproduction 
workflow, save it by clicking on the ... icon on the 
top-right corner of the Base Characteristics tool and 
select Save as Default.

4. Before continuing with your reproduction 
workflow, consider changing the Base 
Characteristics Curve to Linear Response rather 
than Linear Scientific (see Chapter 3.3) and change 
your Output Format to one that is recommended 
for your archive or guideline.

For the Preservation Digital Object (the archival 
master file) choose:

See Chapter 6.4 about the impact of this color 
profile selection on RGB values.

Metamorfoze
Metamorfoze Light
Metamorfoze Extra Light
FADGI 4-star

TIFF 16bit ECI RGB v2
TIFF 8bit ECI RGBv2 or AdobeRGB 1998
TIFF 8bit Adobe RGB 1998
TIFF 16bit AdobeRGB1998
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Image Quality Analysis  
& Standards Validation

5
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5.1. How and When to Measure
Accuracy of Reproduction – Numerically Defined
The workflows described in previous Chapters help you produce faithful reproductions – to record with 
the highest objective image quality. In this Chapter we discuss two ways to quantify and track that quality 
numerically, and to compare it against standards such as FADGI and METAMORFOZE. 

When to Include a Target
It is our opinion (argued in our Digitization Program Planning guide available at dtdch.com), that an Object 
Level Target be included alongside the object in every capture. This provides intra-frame annotation of 
the size of the object and confirms the accuracy of the tone, color, and detail to naive future viewers who 
otherwise have no objective way to know whether the image is a faithful reproduction. Including a target in 
every capture also allows managers and administrators to evaluate the consistency of work being produced, 
and to compare the results over time to look for trends and quickly identify emerging issues.

While this target should remain in the Preservation Digital Object it may not be desirable to have it in all 
derivatives. Capture One CH’s AutoCrop tool can be leveraged to create derivatives (for example, a JPG for 
use on the web) in which the target is automatically cropped out.

5.2. Comparing Delt.ae & Golden Thread
Automatic Machine Analysis
Including a target in and of itself, does nothing to quantify the accuracy of reproduction; the target must 
be analyzed. Although it’s theoretically possible to do this by hand in a program like Adobe Photoshop 
this would be impractical. Instead dedicated image analysis programs exist to automatically identify and 
analyze a target and provide easily readable results such as “pass/fail” or “4 Star FADGI Compliant”. Two 
popular such programs are the website Delt.ae and Golden Thread (made by Image Science Associates). 

Delt.ae: Free, Online, But Limited
The first is a website run by Picturae. It is free to use and does not require installation or licensing. It 
provides basic feedback on sharpness, color and tone accuracy, noise and mis-registration, and illumination 
uniformity. However it has four major limitations. First, at the time of writing of this guide it had not been 
updated since 2012, which means it lacks more recent targets such as the ISA Standard Film Target 
and updates to standards such as the FADGI 2016 update. Second, it is an online service only, with no 
desktop agent to upload files which limits it’s speed/utility for higher volume analysis. Third, it provides very 
limited batch comparison functionality, limiting the view of multiple files to showing only a few columns 
of feedback. Finally, it’s algorithms are fairly generic and do not account for some of the more nuanced 
elements of analyzing a target (see the next paragraph for more details). Still, this tool is free and a new 
user can get started using it in just a few minutes.

Golden Thread by Image Science Associates
Created and maintained by image scientist Don Williams, Golden Thread is commercial desktop software 
which provides a more robust, detailed, and complete set of image analysis tools. Its support is ongoing 
and new targets and revised imaging standards are incorporated soon after becoming available. It runs on 
the desktop (no uploading of large files required) and provides a complete set of comparison tools. Finally 
the algorithms are tweaked for maximum accuracy. As one example Golden Thread includes high-accuracy 
real-world measurement of each supported target to know exactly how sharp the target actually is; this can 
lead to a difference of several percent of sampling efficiency. Golden Thread also actively seeks out areas of 
each color/tone patch that are clean, avoiding the dust and mar issues that routinely effect the accuracy 
of other image analysis software. The software requires payment, installation, and activation, but is our 
suggested solution for any institution serious about analyzing and monitoring image quality.
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Example procedure for verification of an image to 
Metamorfoze and FADGI Imaging Guidelines using 
www.delt.ae with a Golden Thread Device Level 
Target:

1. Open www.delt.ae in your Browser and login into 
your account with your Email address and Password. 
If you are new to this service please register.

3. Once upload is complete the file will process automatically and you can click on results to see the report.

2. Upload your file.

5.3. Delt.ae Workflow
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4. Results of the Golden Thread Device Level Target 
for FADGI Imaging Guidelines: You will find the 
rating for Spatial Accuracy and Color Accuracy in the 
two top boxes.

5. In the Guideline box, on the right, you can choose 
between the different Guidelines. The results appear 
in the two top boxes. The image to the right shows 
the ratings according to the Metamorfoze Imaging 
Guideline.

6. If you select None in the Guideline box, you will 
see all measured results in numbers in the upper 
boxes.
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Example procedure for verification of an image to FADGI Imaging Guidelines using Golden Thread with a 
Golden Thread Device Level Target: 

The steps below assume Golden Thread is already installed and activated per the Installation Guide.

2. Select a Test Profile. 

Golden Thread is more flexible than Delt.ae in the 
criteria (called “Test Profiles”) against which the 
test image is compared. Each Test Profile specifies 
a combination of Color Profile, Capture PPI, and 
target FADGI star rating. Common Test Profiles are 
preloaded; [Create / Edit Profile] can create creation 
of additional custom profiles. 

Color Profile: The correct RGB values depend on the 
color profile used. Therefore the Test Profile specifies 
the intended color profile.

Capture PPI: The ability to test against a specific 
Target PPI is useful when an institution, client, or 
manager has specified a Target PPI to be used. In 
this case FADGI mandates the actual capture PPI be 
within a specific percentage of that target PPI.

Target FADGI Rating: The preloaded profiles set 
benchmarks based on FADGI 1-star, 2-star, 3-star, 
or 4-star quality. It is our opinion (argued in our 
Digitization Program Planning guide available at 
dtdch.com), that all digitization should be done to 
the highest possible quality.

5.4. Golden Thread Workflow

1. Select the type of target you captured.
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3. Select the file.

4. Select to use the ICC profile

For most workflows it makes sense to analyze the 
file based on the ICC Profile embedded in that file. 

5. Click Crop & Identify. Check results.

Golden Thread will automatically identify, rotate, 
and deskew the target from the image.

For larger files analysis may take a minute or two.

The user interface will then highlight in green 
rectangles all of the regions of interest (ROIs) that 
will be used for analysis. Check that these ROIs align 
well to the target.

NOTE:  Golden Thread uses a sophisticated 
algorithm to identify the most consistent area 
within each patch. This helps avoid errant readings 
caused by dust or small imperfections on the target. 
When checking the ROIs ensure only that each ROI 
falls entirely within the intended patch.
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6. Click Run.

For larger files analysis may take a minute or two.

7. Review Results

Detailed analysis of the abundant feedback 
provided by Golden Thread is outside the scope of 
this document. 

However, the summary tab is a good place to start 
any evaluation. If all metrics are passing further 
scrutiny is not generally required. If a metric is failing 
dive deeper to see which specific measurement is 
failing, and by how much. Scale is very important 
in this regard; the summary tab will indicate the 
same “FAIL” evaluation of metrics that are narrowly 
outside the acceptable value range, as on values 
that are wildly incorrect.  

If the measurements are significantly deficient look 
for any trends or patterns to help establish theories 
as to what is causing the issue.

NOTE: By default Golden Thread loads the first 
analysis tab (OECF Curves). In [File > Settings] this 
can be modified to first load another tab such as 
Summary.

8. Data Comparison

The menu item [Tools > Data Comparison...] brings 
up an interface that is useful to compare the results 
from 2 or more files.

For example, an experienced manager may produce 
a reference capture and have their operators 
produce a target at the start of every shift. Data 
Comparison can then be used to compare the 
stability/consistency of the results of those operators.
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1. Check your Proof Profile Settings

See Chapter 6.4 and ensure that you select an 
overlay labeled for use with the output color profile 
you are using.

5.5. Visual Overlay
Visual overlays for the ColorChecker SG Target and Golden Thread ISA Targets can be found on at
www.dtdch.com/dtdch-nominal-target-overlays/. These can be used in Capture One CH to provide a visual 
comparison of a captured target to its nominal values. 

2. Select the Overlay File in the Overlay Tool

In the CH Admin workspace this is located under 
the Admin tab. To add to another workspace right 
click in the tools and select Add Tool > Overlay.

Drag the overlay file from the Finder to where it says 
“Drop image here” or click the [...] and select the file.

3. Resize & Move Overlay; Set Opacity to 100%

Using the Scale, Horizontal, and Vertical sliders 
move the target to fit the capture of the target. Set 
the opacity to 100%.
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Other Considerations

6
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6.1. Capture One CH LAB Readouts
LAB in Other Apps
Most ICC profiles can be interpreted in several ways. To obtain the same results as a 3rd party 
implementation, it is necessary to select an interpretation that matches this behavior. This is done under 
[View > Lab Readout]. Capture One CH supports many variations on the interpretation. However, in some 
circumstances it may be necessary to configure the 3rd party application as well. Generally, it is necessary 
to disable Black Point Compensation (BPC) in the 3rd party application for color spaces that are unable 
to represent black. Note that some applications enables BPC when the Perceptual rendering intent is 
selected regardless of any other setting. Also note that LAB values are not available when using “Embed 
Camera Profile” as your output recipe (as in Chapter 5 “Workflow for In-Situ ICC Profiles”).

Generic
There are two generic options available in Capture 
One: Generic (D50) and Generic (media white). 
The first converts Lab values using D50 as the 
white point. This will match most 3rd party 
implementations including the following: Delt.
ae (by Picturae) and CMS (by Marti Maria). The 
second option, which uses media white as the white 
point, can be used to match colors while avoiding 
chromatic adaptation. For this option, the Lab 
coordinates need to be measured with a device that 
takes into account the light source of the specific 
profile. For sRGB and Adobe RGB (1998), this is D65. 

Adobe Photoshop
By default, Adobe Photoshop® uses the Adobe Color 
Engine (ACE) for color management. To match this, 
select one of the Adobe modes: Adobe (generic) or 
Adobe (neutral). The latter should be chosen for the 
sRGB profile, because ACE may detect that a certain 
ICC-profile is an sRGB profile and silently fix any 
technical issues. 

Also, since Capture One does not support Black 
Point Compensation it is necessary to disable this in 
Photoshop to match output profiles that are unable 
to represent black. To this end, it is necessary to 
disable BPC. Even if BPC is disabled, Photoshop® 
may still apply BPC if the Perceptual intent is 
selected. Thus the following settings should be used 
in Photoshop under Color Settings. 

Golden Thread (Image Science Associates) 
Golden Thread, by Image Science Associates, can analyze an image using either an ICC profile or a built-in 
specification of a standard color space. If you set Golden Thread to use the ICC profile, then in Capture One 
CH select [LAB Readout > GoldenThread (ICC)]. Otherwise select [LAB Readout GoldenThread (standard)] 
option. Note that the output profile in Capture One must match the option used in the analysis. While 
Golden Thread will not use the profile directly in this mode, Capture One CH must still apply the conversion 
to the correct color space.
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There are several important advantages of using a reprographic camera system vs. a scanner for digitization 
project purposes.

Image Quality
The reprographic camera system delivers an extremely high-resolution capture, with accurate colors 
and a very high dynamic range. The camera system delivers instant captures and it does so without any 
movements of the subject matter, or of the sensor. Thus compared to a scanner, the reprographic camera 
system is faster, it is free of maintenance, and it delivers the highest quality “scans”, complying with the 
toughest requirements of FADGI 4 Star, Metamorfoze, and ISO guidelines. On top of that, the reprographic 
camera system is less susceptible to environmental influences of vibration, dust and false light getting into 
the capture.

RAW Workflow
Every capture made by a reprographic camera system using digital back technology produces a RAW file 
with all the captured pixel information, all associated basic transformations (color, etc) and all metadata. 
No matter what transformations or processing the raw file is used for, it is always kept intact as RAW. This 
means you can, at any time, revert to the original file and use the data for new transformations and new 
purposes. The creation of RAW images happens without the bias of operators and manufacturers, and it 
provides the user with the highest degree of control and the ability to create a true preservation digital 
asset.

Almost all scanner-based solutions assume a given target output file format and output specification and 
deliver the scans accordingly. Many Repro Scanners have built in Curves, Color and Sharpening attributes 
that cannot be turned off. The resulting scans cannot be re-purposed. 

Productivity / Preflight
The reprographic camera may take a little more effort for initial set-up of the scanning environment and 
for preparing the daily production. To ease this, the objects to be digitized are usually collated by size 
(i.e. doing a batch of A4 sized items followed by a batch of A2 items, rather than switching many times 
between those two sizes. This supports a two-stage workflow:
 - Preflight operations performed to set up for a given object size
 - Production workflow for capturing many objects of that size

These workflows are supported by specific Workspaces of Capture One CH, which when selected, sets the 
user interface to include only the needed functions.

Below are the default CH workspaces of Capture One CH:

6.2. Advantages Of Instant Capture
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6.3. Target Reference Values

Values using LINEAR RESPONSE and Golden Thread ICC LAB Method (see Chapter 6.1)

Adobe RGB 1998 
Gamma 2.2 

ProPhoto RGB  (ROMM) 
Gamma 1.8  

ECI-RGB-v2 (L*) Embed 
Gamma 
1.8

RGB LAB RGB LAB RGB LAB RGB

ColorChecker SG E5 231* 91.8 225* 91.8 234* 91.8 225

ColorChecker SG F5 195 79.3 184 79.3 203 79.3 184

ColorChecker SG G5 156 65.1 140 65.1 166 65.1 140

Golden Thread 10 233 92.6 228 92.6 236 92.6 228

Golden Thread 13 202 81.8 192 81.8 209 81.8 192

Golden Thread 15 149 62.2 132 62.2 149 62.2 132

Values using LINEAR SCIENTIFIC and Golden Thread ICC LAB Method (see Chapter 6.1)

Adobe RGB 1998 
Gamma 2.2 

ProPhoto RGB (ROMM)
Gamma 1.8  

ECI-RGB-v2 (L*) Embed 
Gamma 
1.8

RGB LAB RGB LAB RGB LAB RGB

ColorChecker SG E5 245 96.5 242 96.5 246 96.5 242

ColorChecker SG F5 195 79.4 184 79.4 203 79.4 184

ColorChecker SG G5 156 65.1 140 65.1 166 65.1 140

Golden Thread 10 246 97.1 244 97.1 248 97.1 244

Golden Thread 13 203 82.1 193 82.1 209 82.1 193

Golden Thread 15 149 62.2 132 62.2 159 62.2 132

These values are based on an average example of each target type. Every physical target manufactured will 
vary slightly from the average. Golden Thread now measures every specific ISA target and uses a QR Code 
to pass those values to Golden Thread. For other targets we suggest you measure your specific target using 
a colorimeter and software such as SpectraShop by Robin Myers (see Chapter 6.5)

*Because of the slight highlight rolloff in the Linear Response curve very small changes in exposure can 
change the highlight patch values by several digits. Therefore when using Linear Response it is easier and 
more consistent to set exposure based on gray patches as noted in Chapter 3.7.

Note: By default Capture One CH proofs the on-screen image (and therefore any RGB values) using the 
color profile of the selected recipe. See Chapter 6.4 for more information.
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1. Check the setting of View > Proof Profile

The default option is “Selected Recipe”. 

This is a good option as long as you stay aware of 
which recipe is selected.

6.4. Soft Proofing & RGB Values
The RGB values of an image change based on which color profile is applied to that image. Even when no 
visual change takes place they can be radically different. This is because RGB values are mathematically 
tied to the color space you measure them in, unlike LAB values which are independent of the color space. 

By default, Capture One proofs the on-screen image (and therefore any RGB values) using the color profile 
of the selected recipe. For example, if you create two output recipes, using ProPhoto RGB for one and 
Adobe (1998), for the other and switch between them you’ll notice the RGB values of any given patch value 
change, even though the visual appearance of the target does not.

Therefore, when using RGB values, it is very important to be aware of the recipe you have selected, and to 
use the values that are relevant to that color profile in table 6.4. The steps below help you check this:

2. Check the Color Profile of the Selected Recipe

In the process recipes the orange highlighted recipe 
is said to be “selected” while a checkbox is used 
to indicate if the recipe is “enabled” (and will be 
included in the recipes used when you select to 
process).

In your selected recipe you need to specify the ICC 
profile to be used for the destination workspace. 
Color values in Capture One are now in relation to 
that workspace.
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6.5. Spectral Evaluation
This guide has focused on the basics of attaining a faithful reproduction of the original material. But color 
in particular is a very complicated topic; entire academic tomes have been written about the nature and 
science of color. Color is a sensation created in a viewer by the combination of the spectral response of 
the physical object, the spectral output of the light falling on it, and the physiological and psychological 
response of the viewer. Therefore you cannot define a “color” without specifying an illuminant, and 
consumer terms such as “6500 Kelvin” is insufficient to fully describe the spectrum of a light. Similarly one 
set of RGB or LAB values does not fully describe an object.

Because color is defined by spectrum any investigation into color that is more than skin deep requires tools 
that can measure and work with spectrum rather than RGB or LAB values. Spectral analysis can be used to 
investigate, for example, situations in which the color of two objects match under one type of lighting but 
not another (a situation broadly falling under the term “metamerism”). Another use of spectral analysis is to 
identify the pigments or materials used by an artist without requiring physical samples to be taken.

One powerful tool for spectral analysis is Spectra Shop (www.rmimaging.com/spectrashop.html) made by 
Robin Myers. Among other things SpectraShop can be used, along with a spectrophotometer to:
• Measure the spectrum of a light source, including the CRI, CRI-14, or CQS scores of that spectrum. 
• Measure the patches of a specific physical target as suggested in Chapters 6.3 and 1.4. 
• Measure the spectral content of a specific object to help facilitate identification of its physical makeup.

SpectraShop’s Main Collection Window SpectraShop’s Lighting Evaluation Tool
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Workflow Summaries

7
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7.1. Workflow for Bespoke CH Profiles | Summary

Section Page Step Summary

3.1 11 Set Mode [Base Characteristics > Mode > Photography]

3.2 12 Set Color Profile If using DT Photon: [Base Characteristics > ICC Profile > Cultural 
Heritage - Flat Art Reproduction - LED DT Photon]

If using Strobe: [Base Characteristics > ICC Profile > Cultural Heritage 
- Flat Art Reproduction - Flash]

3.3 12 Set Curve [Base Characteristics > Curve > Linear Response]

3.4 13 Capture LCC File & 

Create LCC

Insert and Capture image of gray cardboard
Right Click thumbnail and select Create LCC

3.5 15 Application of LCC [Next Capture Adjustments > All Other > Copy From Last]

3.6 16 Set White Balance ISA Golden Thread: White balance on patch 13
ColorChecker SG: White balance on patch F5

3.7 17 Set Exposure ISA Golden Thread: patch 15 should have an L value of 62
ColorChecker SG: patch G5 should have an L value of 65

If needed adjust shutter speed (if using DT Photon) or strobe output 
(if using strobe).

This summary is not meant to replace a thorough reading of Chapter 3, but as a quick reference for those 
who have. It assumes the use of Capture One CH with a process recipe set to Adobe 1998 color profile and 
the imaging of flat non-transmissive material.
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7.2. Workflow for In-Situ Profiles | Summary

Section Page Step Summary

4.1 19 Set Mode [Base Characteristics > Mode > Photography]

4.2 20 Set Color Profile [Base Characteristics > ICC Profile > Effects > No Color Correction]

4.3 20 Set Curve [Base Characteristics > Curve > Linear Scientific]

4.4 21 Capture LCC File & 
Create LCC

Insert and Capture image of gray cardboard
Right Click thumbnail and select Create LCC

4.5 22 Application of LCC [Next Capture Adjustments > All Other > Copy From Last]

4.6 24 Set White Balance ISA Golden Thread: White balance on patch 13
ColorChecker SG: White balance on patch F5

4.7 25 Set Exposure ISA Golden Thread: patch 15 should have an L value of 62
ColorChecker SG: patch G5 should have an L value of 65

If needed adjust shutter speed (if using DT Photon) or strobe 
output (if using strobe).

4.8 26 Crop & Export Target Crop target using AutoCrop or manual Crop and Straighten tools
Process using recipe set to 16 bit TIFF with Embed Camera Profile

4.9 29 Create Profile in 
basICColor Input 5

In basICColor 5...
Select CCSG Repro Preset
Drag in the TIFF that was processed in Capture One CH
Follow name template [MakeModel-CustomName.icc]
Click Start Profiling

4.10 31 Set Capture One to 
Use Profile

Restart Capture One
[Base Characteristics > ICC Profile > Your Profile Name]
[Base Characteristics > Curve > Linear Response]
[... > Save as Default]

This summary is not meant to replace a thorough reading of Chapter 4, but as a quick reference for those 
who have. It assumes the use of Capture One CH and basICColor 5.
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